
Next Meeting:  Wed. Sept. 10th,  2008  -   7:00pm
Chair: Allyson BarnesChair: Allyson BarnesChair: Allyson BarnesChair: Allyson BarnesChair: Allyson Barnes
Judge:  Chris ZsarnayJudge:  Chris ZsarnayJudge:  Chris ZsarnayJudge:  Chris ZsarnayJudge:  Chris Zsarnay
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The Ventura County Camer Club meets
on the second Wednesday

of every month at 7:00pm at the
 Pointsettia Pavillion

Ventura Woman’s Center
3451 Foothill Rd.

Ventura, CA 93003
805/648-1143

Ventura County Camera Club
Through the Viewfinder

September   2008

 For a full listing of the VCCC
rules, check the website at:

wwwwwwwwwwwwwww.V.V.V.V.VentententententurururururaCountaCountaCountaCountaCountyCameryCameryCameryCameryCameraCaCaCaCaClublublublublub.com.com.com.com.com

 

Page 1

FUTURE CATEGORIES
Barnes Blather

VCCC   OFFICERS

President               Allyson Barnes
V.P.                           Anne Allen
Treasurer              Chuck Castaing
Judge Locator      Les Ammann &
                                  Bryan McCall
Digital Coord.      Susannah Kramer
Website                  Bob Murtha
Newsletter             Anne Allen
Workshop              Leigh Lopez &
Coordinator         Jean Castaing
Refresh.  Coord    Don Hoffman
Membership          Roy Allen
Entries &                Frank Naumann
Announcing         Bob Murtha
Public Relation    John Ferritto

Sept 10th:     Old Architecture
Oct 8th:        Street Scenes
Nov 12th:     Cemeteries
December:    NO MEETING
January 14th, 2009 --TBD
January 28th:   BANQUET

Al Ungar & Neil Bordofsky

Lessons Learned from the Young and Older Generations

     Recently I started a class at Moorpark College with a couple other

members of our photo club. We were playing with studio lighting and
were using a high tech light meter. The instructor himself wasn’t familiar
with this particular advancement in  meter technology (which could also
be used to do your laundry). So one of the students said, “I don’t know
how to use this thing but I bet I can figure it out.” Sure, this kid is one of
those gifted human beings who came out of the womb with an inherent
understanding of gadgets, but his fearlessness impressed me. I found out
he has decided to double major in Photography and Photojournalism and
from what I have seen and heard, nothing will stop him. His example
inspired me to remember what it is like to be curious, eager and willing to
try just about anything!     Speaking of youth...this same evening I was
talking to someone probably more than ten years younger than I. She
expressed her doubts about starting something new at her age. We all
know that age is a matter of perspective (don’t we?) and I offered my take
on the matter. I plan to live at least 40+ more years and if I took just one
picture a week.....that would be a conservative estimate of 2080
photographs. Now there’s some room for improvement! - ab

     We want to thank Ines Roberts for an  outstanding evening of constructive
criticismand professional photo insight.  We always  enjoy her talent and
humor but mostly, we appreciate her sharing her secrets.
We had an excellent turn out for the voting on images of Ventura to be dis-
played in the Poinsettia Lobby.  Come on in and check out the images of Pat
Osborne, Lloyd Nakatani, Susannah Kramer, Frank Naumann, Darrel Priebe,

and Jean Castaing and Roy& Anne Allen.

      A warm welcome to our new member Harold Epstein and returning
member Pat Hester.



From the Couch of
  “Photo Froyd”

     The days are growing shorter.  The summer foliage will soon turn to bright shades of yellow, orange
and red before they drop and expose the bare trees.  Temperatures will drop and some animals will turn
in for that long Winter’s nap.  Yes, Fall will soon be upon us, followed by Winter.  But for us
photographers, it’s no time to nap or even take a snooze.  The young ones are back in school and the
summer crowds are gone.  Photo opportunities are everywhere.  This is probably my favorite time of
year.  Excitement is in the air.  The Fall colors in the High Sierras are super.  Ever been to the narrows
in Zion National Park in the Fall?  It’s a definite WOW! not to mention Yellowstone and our own
Yosemite plus many other places.  If you sit home contemplating your navel, “you’re burning daylight”,
or in this case, photo opportunities.  So let’s get those creative juices flowing and go out and make
some really unique images.  Yes, let’s be creative.  Mother Nature has made available to us this wide
pallet of colors, patterns and textures, so why not capture and keep forever some of the beauty.  They
say beauty is in the eye of the beholder. So, let’s put some of this beauty in print so those who do sit
home contemplating, can see what they’ve missed.  Enthusiasm and excitement are contagious.
Through our images we are helping others share the beauty of nature and all the benefits it has to
offer.  As Ventura County residents, we don’t have to go far.  Just outside our back door is usually a
good start.  Just this morning,  I spotted four large caterpillars on a bush next to my garage.  Maybe in
a few weeks they will be beautiful butterflies.  So, wash off the haze on those old glasses you are
wearing, charge the batteries in the camera, get a empty CF card and capture some of this beauty and
put it into print for others to enjoy.

All the best,
Photo Froyd

CongrCongrCongrCongrCongratu lat ionsatu lat ionsatu lat ionsatu lat ionsatu lat ions

Congratulations to Susannah KrSusannah KrSusannah KrSusannah KrSusannah Kramer amer amer amer amer for her spectacular photo “Fourth of July Splash”
that won a runner-up recognition in the Special Effects competition at Double Exposure. You
can see all the runners up here:
http://www.doubleexposure.com/de_assignments/effects/index.html
The three winners are here:
http://www.doubleexposure.com/DEChallenge_SpecEffects.shtml
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 Exhibits and Local Events Exhibits and Local Events Exhibits and Local Events Exhibits and Local Events Exhibits and Local Events

In the 9/2/08 STAR,  there was an article about an artist and photographer
 Phil FPhil FPhil FPhil FPhil Foster Rangeroster Rangeroster Rangeroster Rangeroster Ranger, who will be exhibiting his work on Ventura at the:

TTTTTool Room Galleryool Room Galleryool Room Galleryool Room Galleryool Room Gallery,
 Bell Arts Factory,

432 N. Ventura Ave., Ventura.
The exhibit will run from Friday, Saturday and Sunday through October 12.

 The gallery hours are 2:30pm  to 4:30pm
For more info visit: www.fragilesands.com

Santa Barbara Sand Castle Festival
Saturday 9/13 - East Beach, Santa Barbara

info at: www.sandcastlefestival.com

Gold Coast PirGold Coast PirGold Coast PirGold Coast PirGold Coast Pirate Fate Fate Fate Fate Fairairairairair
Sept. 20-21 & 27-28

Lake Casitas, Lake Casitas Recreation Area
info at: www.goldcoastfestivals.com

Vintage Outlaw Motocycle RacesVintage Outlaw Motocycle RacesVintage Outlaw Motocycle RacesVintage Outlaw Motocycle RacesVintage Outlaw Motocycle Races
Sept. 27th at the Ventura Raceway, Ventura County Fairgrounds

Info at: www.vintageoutlawraces.com

Buenaventura Gallery
700 E. Santa Clara St,  Ventura

648-1235
“UpUpUpUpUp, D, D, D, D, Down & All Around: Photogrown & All Around: Photogrown & All Around: Photogrown & All Around: Photogrown & All Around: Photographic Reflections in Black and White”  by Gail Lansburyaphic Reflections in Black and White”  by Gail Lansburyaphic Reflections in Black and White”  by Gail Lansburyaphic Reflections in Black and White”  by Gail Lansburyaphic Reflections in Black and White”  by Gail Lansbury

Through Sept. 13th,
Noon to 5pm. Tuesday through Fridays and 11am to 5 p.m. Saturday

Info at: www.buenaventuragallery.org

Jonathan’s at Peiranos
204 E. Main St.m Ventura

648-4853
Through Oct. 28th

“ NaturNaturNaturNaturNature Photogre Photogre Photogre Photogre Photography On Canvaphy On Canvaphy On Canvaphy On Canvaphy On Canvasasasasas”
by Mark and Holly Jansen

Info at:http://jonathansatpeiranos.com

Page 3



Digital pDigital pDigital pDigital pDigital pDigitalDigitalDigitalDigitalDigitalDiva1Diva1Diva1Diva1Diva1

An upcoming photography exhibit at the Los Angeles County Museum of Art due in October 08:
http://www.lacma.org/art/ExhibVernon.aspx

A Story of Photography: The Marjorie and Leonard Vernon Collection
October 5, 2008–February 1, 2009 | Ahmanson Building
A Story of Photography will present highlights of LACMA’s newly acquired Marjorie and Leonard Vernon
Collection. The collection of more than 3,500 photographs forms one of the finest existing groups of masterworks
from the nineteenth and twentieth centuries. The exhibition, opening on October 5, will show over seventy seminal
photographs by Ansel Adams, Julia Margaret Cameron, Edward Steichen, Paul Strand, W.H. Fox Talbot, and
Edward Weston. Announced on August 11, the acquisition was made possible by a groundbreaking gift from Wallis
Annenberg and the Annenberg Foundation in support of photography. In addition to acquisition of the Vernon
Collection, the gift includes a contribution to a new study room, opening in early 2011, that will allow access to the
entire photography collection at LACMA. Marjorie and Leonard Vernon were pioneer Los Angeles collectors who,
beginning in the 1970s, amassed a group of works with global significance that especially highlighted the riches of
West Coast photography in the early and mid-twentieth century. The collection grew over the years to include
works by 700 photographers, with the earliest photographs dating from the 1840s.
This exhibition was organized by the Los Angeles County Museum of Art. The Marjorie and Leonard
Vernon Collection acquisition was made possible by a major gift from the Annenberg Foundation and
the generous support of Carol Vernon and Robert Turbin.
Imogen Cunningham (United States, 1883-1976), Magnolia Blossom, 1925, gelatin silver print, 9 1/8 x 11
1/2 in., M.2008.40.599, The Marjorie and Leonard Vernon Collection, gift of The Annenberg Foundation and Carol

Vernon and Robert Turbin, © 2008 The Imogen Cunningham Trust.
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Also, the directors of Food Share, Fran McNeill, & Mel Dick  are still asking for more food/Ventura crop related photos to

display on their walls.   If you need to get a contact for that, ask John Ferritto or Mel Dick at:   Food Share, Inc.

www.foodshare.com             Mel’s cell phone: 805-218-2883
                                          4156 Southbank Road
                                          Oxnard, CA 93036
                                          805-983-7100
                                FAX 805-983-3376
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Digital DivaDigital DivaDigital DivaDigital DivaDigital Diva

Sizing and PSizing and PSizing and PSizing and PSizing and Prrrrreparing Digital Files for Competitioneparing Digital Files for Competitioneparing Digital Files for Competitioneparing Digital Files for Competitioneparing Digital Files for Competition
When we prepare our files for digital projection they need to fit certain parameters, not only of size,
but to look their best also color profile and quality.

This rectangle cannot be rotated like a slide in
a slide projector, so all files must be sized to
fit within this landscape mode space.

First the size.  Our projector has a resolution
of 1024pixels wide by 768 pixels high as shown
in the diagram #1 to the left.

First let’s look at  landscape mode image #2

In Photoshop go to Image>Image Size, and a
dialog box will come up showing you the pixel
width and height of your file.  (All other imag-
ing programs have some version of this).

With the resample image and the constrain
proportions boxes  checked we have put in a

As you can see in #3 although this image fits
within the width required at a height of 789
pixels it is too tall for our space.  So now we
must change the height to 768.   In image  #4
you can see how it now fits within our required
space.

width of 1024

#1#1#1#1#1

#2#2#2#2#2

#3#3#3#3#3

Page 5



#4#4#4#4#4

A very wide image would fit thus:

The next step is to convert the color
profile for the best one for web, email
and projection.  Go to Edit>Convert to
Profile and choose sRsRsRsRsRGBGBGBGBGB from the
DDDDDestination Space estination Space estination Space estination Space estination Space drop down menu
as shown in  #6.

Now we are ready to save our file to the
appropriate folder. Go to File>Save As.
It’s important at this point to do aIt’s important at this point to do aIt’s important at this point to do aIt’s important at this point to do aIt’s important at this point to do a
“S“S“S“S“Savavavavave As”so that we don’t lose oure As”so that we don’t lose oure As”so that we don’t lose oure As”so that we don’t lose oure As”so that we don’t lose our
original file, original file, original file, original file, original file, you certainly don’t want
to be stuck with this small file as your

#5#5#5#5#5

#6#6#6#6#6

will change your original file forever, but if you click “Save As” it will put your original file away un-
touched and allow you to name your new version for competition.  In the space for “file name” “file name” “file name” “file name” “file name” put
your Lastname Firstname_FileName_assigned.jpgLastname Firstname_FileName_assigned.jpgLastname Firstname_FileName_assigned.jpgLastname Firstname_FileName_assigned.jpgLastname Firstname_FileName_assigned.jpg

This is the format for naming your files, either assigned or open, choose jpg from the drop down
menu for “F“F“F“F“Format” ormat” ormat” ormat” ormat” and then click SSSSSavavavavave.  e.  e.  e.  e.  A     dialog box will come up with quality options for saving
your file, in Photoshop choose 12 or whatever the highest quality choice is in your program.  (D(D(D(D(Dooooo
not put anything after the categorynot put anything after the categorynot put anything after the categorynot put anything after the categorynot put anything after the category, open or assigned, if you wish to put a date put it, open or assigned, if you wish to put a date put it, open or assigned, if you wish to put a date put it, open or assigned, if you wish to put a date put it, open or assigned, if you wish to put a date put it
after the file name and beforafter the file name and beforafter the file name and beforafter the file name and beforafter the file name and before the categorye the categorye the categorye the categorye the category. . . . .  At the end of the year there are hundreds of
files to be sorted for the final competition and I get very grumpy if I have to search through the
filename for the information I need!).
Now you are ready to attach it to an email and send it to me at  noonum@verizon.netnoonum@verizon.netnoonum@verizon.netnoonum@verizon.netnoonum@verizon.net

Happy shooting,
Susannah
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OpenOpenOpenOpenOpen

       Assignment:   Beach Scenes

                                      Ocean & Seashores
      August   Judge:  Ines Roberts

PPPPPrint Meritsrint Meritsrint Meritsrint Meritsrint Merits

AssignedAssignedAssignedAssignedAssigned

Digital Slide MeritsDigital Slide MeritsDigital Slide MeritsDigital Slide MeritsDigital Slide Merits
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Black & WhiteBlack & WhiteBlack & WhiteBlack & WhiteBlack & WhiteColorColorColorColorColor
Anne Allen             1)  Painted Reflection
                              2) Surfer & Woodie Board

Neil Bordofsky         Lucky Over Seattle

Hutch Hutchison    Mission Door

Bob Pedersen          Two Bee Sure

Ed Pinsky         I’ll Keep An Eye Out For You

Darrel Priebe:        1)  Birds Of A Feather
                              2)  All Aglow

Darrel Priebe     Memories Of Long Ago

Al Ungar     Magic Moment

Hutch Hutchison - E Ticket Ride
Hutch Hutchison - Fire In The Sand
Susannah Kramer - Ruby Beach Reflections
Susan Magness - Brookings Bay
Patricia Marroquin - The Pelican Brief

Ron Matson - Breakers at Sunset
Lloyd Nakatani - Ocean Party
Gina Ramsay - Golden Sand

Hank Stoutz - Antarctic Sunrise

Roy Allen -  Butte at Sunset
Allyson Barnes -  Between Storms
Les Ammann - Up Up & Away
John Ferritto - Water
Lynn Gordon - Hew Haw
Leigh Lopez - Smiling for the Camera
Susan Magness - Pears
Patricia Marroquin:
      1) Sunrise Over Santa Paula
     2) The Thrill Is Not Gone
Ron Matson - Man With Load
Ron Matson - Tools
Lloyd Nakatani:   1)  AnneMarie
                             2) Cynthia
Gina Ramsay - Antique Dream
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AAAAAugust  Showcaseugust  Showcaseugust  Showcaseugust  Showcaseugust  Showcase
     Monthly Merits     Monthly Merits     Monthly Merits     Monthly Merits     Monthly Merits

Hutch Hutchison - E Ticket Ride

Hutch Hutchison - Fire In The Sand

Susannah Kramer - Ruby Beach Reflections

Susan Magness - Brookings Bay

Hank Stoutz - Antarctic Sunrise

Patricia Marroquin - The Pelican Brief

Ron Matson - Breakers at Sunset

Gina Ramsay - Golden Sand

Lloyd Nakatani - Ocean Party

Digital AssignedDigital AssignedDigital AssignedDigital AssignedDigital Assigned
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Lynn Gordon - Hew Haw

Susan Magness - Pears

Ron Matson - Tools

Lloyd Nakatani - Cynthia

Gina Ramsay - Antique Dream

Digital OpenDigital OpenDigital OpenDigital OpenDigital Open

Les Ammann - Up Up & Away

Leigh Lopez - Smiling For The Camera

Lloyd Nakatani - AnneMarie
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Roy Allen - Butte At Sunset

Allyson Barnes - Between StormsJohn Ferritto - Water

Patricia Marroquin - Sunrise Over Santa Paula

Ron Matson - Man With Load

Patricia Marroquin - The Thrill Is Not Gone
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PPPPPrints  Colorrints  Colorrints  Colorrints  Colorrints  Color

The End

Anne Allen - Painted Reflection Anne Allen - Woodie and Board


